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Chapter 1
The User Coordinate

System

Learning Objectives
After completing this chapter, you will be able to:
• Understand the concept of World Coordinate System (WCS)
• Understand the concept of User Coordinate System (UCS)
• Control the display of UCS icon
• Change the current UCS icon type
• Use the UCS command
•	Dynamically move and align the UCS
• Understand different options for changing UCS using the UCS tool
• Change UCS using the Dynamic UCS button
• Manage UCS through the UCS dialog box
• Understand different system variables related to the UCS and the UCS icon
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THE USER COORDINATE SYSTEM (UCS)
When you start a new drawing in AutoCAD, the world coordinate (WCS) system is established 
by default. The objects you draw uses the WCS to locate itself in the drawing space. In WCS, 
the  X, Y, and Z coordinates of any point are measured with respect to the fixed origin (0,0,0). 
By default this origin is located at the lower left corner of the screen, by nature this coordinate 
system is fixed and can not be moved. Generally 2D drawings, wireframe models, and surface 
models can be created in WCS but in the case of solid models it is not possible to keep the origin 
and the orientation of the X, Y, and Z axes at the same place every time. The reason for this is 
that in case you want to create a feature on the top face of an existing model you will need to 
shift the working plane to the top face of the model. This can be done by using Elevation option 
of the ELEV command, see Figure 1-1. But, on using the ELEV command, it is not possible to 
create a feature on the faces other than the top and bottom faces of an existing model.

This problem can be solved by the user coordinate system (UCS). Using the UCS, you can 
relocate and reorient the origin and X, Y, and Z axes and establish your own coordinate system, 
depending on your requirement. The UCS is mostly used in 3D drawings, where you may need to 
specify points that vary from each other along the X, Y, and Z axes. It is also useful for relocating 
the origin or rotating the X and Y axes in 2D work, such as ordinate dimensioning, drawing 
auxiliary views, or controlling the hatch alignment. The UCS and its icon can be modified using 
the UCSICON and UCS commands. After reorienting the UCS, you can create a feature on any 
of the face of an existing model; see Figure 1-2.

Figure 1-2  Creating a new feature on the 
side face

Figure 1-1  Creating a new feature on the top face

CONTROLLING THE VISIBILITY OF THE UCS ICON
  Ribbon:  View > Viewport Tools > UCS Icon 						         
  Menu Bar:  View > Display > UCS Icon > On                            Command:  UCSICON	   

The UCS Icon tool is used to control the visibility and location of the UCS icon, which is a 
geometric representation of the directions of the current X, Y, and Z axes. AutoCAD displays 
different UCS icons in model space and paper space, as shown in Figures 1-3 and 1-4. By default, 
the UCS icon is displayed near the bottom left corner of the drawing area. You can change the 
location and visibility of this icon using the UCSICON command. The prompt sequence for 
the UCSICON command is given next.
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Enter an option [ON/OFF/All/Noorigin/ORigin/Selectable/Properties] <ON>: You can 
specify any option or press ENTER  to accept the default option.

Figure 1-3  The UCS icon in the Model space Figure 1-4  The UCS icon in the Paper space

ON
This option is used to display the UCS icon on the screen. You can also display the UCS icon by 
choosing the Show UCS Icon button from the Coordinates panel in the Home tab.

OFF
This option is used to make the UCS icon invisible from the screen. When you choose this option, 
the UCS icon will no longer be displayed on the screen. You can again turn on the display using 
the On option of the UCSICON command. Alternatively, choose the Hide UCS Icon button 
from the Coordinates panel in the Home tab to make the UCS icon invisible.

All
This option is used to apply changes to the UCS icon in all active viewports. If this option is not 
used, the changes will be applied only to the current viewport.

Noorigin
This option is used to display the UCS icon at the lower left corner of the viewport, irrespective 
of the actual location of the origin of the current UCS. Alternatively, choose the Show UCS Icon 
at Origin button from the Coordinates panel in the Home tab.

ORigin
This option is used to place the UCS icon at the origin of the current UCS.

Selectable
This option allows you to control the selection of UCS. By default, UCS is selectable.

Properties
When you invoke this command, the UCS Icon dialog box will be displayed, as shown in Figure 
1-5. You can also display this dialog box by choosing the UCS Icon, Properties tool from the 
Coordinates panel in the Home tab. The options in this dialog box are discussed next. 
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UCS icon style Area
The options in this section are discussed next.

3D. If this radio button is selected, the 3D UCS icon will be displayed in the model space. 
By default this option is already selected. 

2D. If this radio button is selected, the 2D UCS icon will be displayed instead of the 3D 
UCS icon, see Figure 1-6. 

Line width. This drop-down list provides the width value that can be assigned to the 3D 
UCS icon. The default value for the line width is 1. This drop-down list will not be available 
if the 2D radio button is selected.

Figure 1-6  2D UCS icon at the World positionFigure 1-5  The UCS Icon dialog box

UCS icon color Area
The UCS icon color area in this dialog box has two drop-down lists, Model space icon color 
and Layout tab icon color. The options of these drop-down lists are used to change the color 
of the UCS icon. By default, the color in the Model space is black and in the Layout is Color 
160. You can assign any color to the UCS icon. By default, there are seven colors in first and 
eight colors in second drop-down list. However, you can also select a color from the Select 
Color dialog box which will be displayed after you select Select Color from the Model space 
icon color drop-down list or the Layout tab icon color drop-down list.

DEFINING THE NEW UCS
  Ribbon:  Visualize > Coordinates > UCS 	 Toolbar: UCS     	  
  Menu Bar: Tools > New UCS			   Command: UCS 	

The UCS tool is used to set a new coordinate system by shifting the working plane (XY 
plane) to the desired location. For certain views of the drawing, it is better to have the 
origin of measurements at some other point on or relative to your drawing objects. This 

makes locating the features and dimensioning the objects easier. The change in the UCS can 
be viewed by the change in the position and orientation of the UCS icon, which is placed by 
default at the lower left corner of the drawing window. The origin and orientation of a coordinate 
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system can be redefined by using the UCS command. Alternatively, choose the UCS tool from 
the Coordinates panel. The prompt sequence after choosing this tool is given next:

 
Current ucs name: *WORLD*
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis] 
<World>: Select an option.

If the UCSFOLLOW system variable is set to 0, any change in the UCS will not affect the 
drawing view.

If you choose the default option of the UCS tool, you can establish a new coordinate system 
by specifying a new origin point, a point on the positive side of the new X axis, and a point 
on the positive side of the new Y axis. The direction of the Z axis is determined by applying 
the right-hand rule, about which you will learn in the next chapter. This option changes the 
orientation of the UCS to any angled surface. The prompt sequence that will follow is given next.

Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis] 
<World>: Specify the origin point of the new UCS.
Specify point on X-axis or <accept>: Specify a point on the positive portion of the X axis. 
Specify point on the XY plane or <accept>: Specify a point on the positive portion of the Y 
axis to define the orientation of the UCS completely.

In AutoCAD, you can directly manipulate the UCS as per your requirement. This implies that 
you can easily move the origin of UCS, align the UCS with objects, or rotate it around X, Y, 
and Z axis without invoking the UCS command. You can also move the UCS and place it at the 
desired location without using any command. To do so, select the UCS; the grips are displayed 
on it. Place the cursor on the rectangular grip displayed at the intersection of three axes of UCS; 
a shortcut menu will be displayed, as shown in Figure 1-7.

Figure 1-7  UCS shortcut menu

Choose the Move and Align option from the shortcut menu; the UCS will be displayed attached 
to the cursor. You can move the UCS to any point but you can align it only with the face of a 
3D object, surface, or mesh. To align the UCS, move it to any point on the face of a 3D object, 
surface, or mesh; the face gets highlighted and the UCS automatically aligns with the orientation 
of that face, surface, or mesh, as shown in Figure 1-8. 

In case of a curved surface, the UCS will get aligned in such a way that the Z-axis becomes 
normal to the surface at the specified point. After aligning the UCS to the selected face, you 
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can change the direction of X axis, Y axis, or Z axis dynamically. You can also use the shortcut 
menu displayed on placing the cursor on the X, Y, or Z grip.

Figure 1-8  UCS aligned to the highlighted face

If you choose World from the UCS shortcut menu, then the UCS will move and align to the 
World Coordinate System. The World Coordinate System is discussed next.
 

Note
Depending upon the type of UCS required, you can choose the corresponding tools available in 
the Coordinates panel of the Home tab.

A null response to the point on the X or Y axis prompt will lead to a coordinate system, in which 
the X or Y axis of the new UCS is parallel to that of the previous UCS.

W (World) Option
With this option, you can set the current UCS back to the WCS, which is the default 
coordinate system. When the UCS is placed at the world position, a small rectangle is 
displayed at the point where all the three axes meet in the UCS icon, see Figure 1-9 (a). 

If the UCS is moved from its default position, this rectangle is no longer displayed, indicating 
that the UCS is not at the world position, as shown in Figure 1-9(b). 

Note
If 2D UCS icon is selected instead of 3D UCS icon and if the UCS is not at the world position; 
the W icon will not be displayed.
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Figure 1-9  UCS at the world position and UCS not at the world position

F (Face) Option
This option is used to align a new UCS with the selected 
face of a solid object. You can invoke this option by choosing 
the Face tool from the Align UCS drop-down in the 

Coordinates panel, as shown in Figure 1-10. The prompt sequence 
that will follow when you choose this tool is given next.

Figure 1-10  The Face tool in 
the Align UCS drop-down

Select face of solid, surface, or mesh: Select the face to align 
the UCS.
Enter an option [Next/Xflip/Yflip] <accept>: Select an 
option or accept the selected face to align. 

The Next option is used to locate the new UCS on the adjacent face or the back face of the 
selected edge. Xflip rotates the new UCS by 180-degree about the X axis and Yflip rotates it 
about the Y axis. Pressing ENTER at the Enter an option [Next/Xflip/Yflip] <accept> accepts 
the location of the new UCS as specified. 

OB (OBject) Option
With the OB (OBject) option of the UCS tool, you can establish a new coordinate system 
by selecting an object in the drawing. However, some of the objects such as 3D polyline, 
3D mesh, viewport object, or xline cannot be used for defining a UCS. The positive Z 

axis of the new UCS is in the same direction as the positive Z axis of the object selected. If the 
X and Z axes are given, the new Y axis is determined by the right-hand rule. You can also invoke 
this option by choosing the Object tool from the Align UCS drop-down in the Coordinates 
panel. The prompt sequence that will follow when you choose this tool is given next.

Select object to align UCS: Select the object to align the UCS.

In Figure 1-11, the UCS is relocated using the OBject option and is aligned to the circle. The 
origin and the X axis of the new UCS are determined by the following rules:
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Arc
When you select an arc, its center becomes the origin for the new UCS. The X axis passes through 
the endpoint of the arc that is closest to the point selected on the object.

Circle/Cylinder/Ellipse 
The center of the circle becomes the origin of the new UCS, and the X axis passes through the 
point selected on the object (Figure 1-12).

Figure 1-12  UCS at a new locationFigure 1-11  Relocating the UCS using a circle

Line/Mline/Ray/Leader
The new UCS origin is the endpoint of the line nearest to the point selected on the line. The X 
axis is defined so that the line lies on the XY plane of the new UCS. Therefore, in the new UCS, 
the Y coordinate of the second endpoint of the line is 0.

Note
The linear edges of solid models or regions are considered as individual lines when selected to 
align a UCS.

Spline 
The origin of the new UCS is the endpoint of the spline that is nearest to the point selected on 
the spline. An imaginary line will be drawn between the two endpoints of the spline and the X 
axis will be aligned along this imaginary line. 

Trace 
The origin of the new UCS is the “start point” of the trace. The new X axis lies along the 
direction of the selected trace.

Dimension
The middle point of the dimension text becomes the new origin. The X axis direction is identical 
to the direction of the X axis of the UCS that existed when the dimension was drawn.

Point
The position of the point is the origin of the new UCS. The directions of the X, Y, and Z axes 
will be same as those of the previous UCS. 
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Solid 
The origin of the new UCS is the first point of the solid. The X axis of the new UCS lies along 
the line between the first and second points of the solid.

2D Polyline 
The start point of the polyline or polyarc is treated as the new UCS origin. The X axis extends 
from the start point to the next vertex.

3D Face 
The first point of the 3D face determines the new UCS origin. The X axis is determined by 
using the first two points, and the positive side of the Y axis is determined by the first and fourth 
points for a flat rectangular face. For a flat planar face, the X axis will always be parallel to the 
edge through which the UCS is moved on the face. The Z axis is determined by applying the 
right-hand rule.

Shape/Text/Insert/Attribute/Attribute Definition 
The insertion point of the object becomes the new UCS origin. The new X axis is defined by 
the rotation of the object around its positive Z axis. Therefore, the object you select will have a 
rotation angle of zero in the new UCS. 

Tip
Except for 3D faces, the XY plane of the new UCS will be parallel to the XY plane of the object 
when it was drawn. However, X and Y axes may be rotated.

V (View) Option
The V (View) option of the UCS tool is used to define a new UCS whose XY plane is 
parallel to the current viewing plane. The current viewing plane, in this case, is the screen 
of the monitor. Therefore, a new UCS is defined that is parallel to the screen of the 

monitor. The origin of the UCS defined in this option remains unaltered. This option is used 
mostly to view a drawing from an oblique viewing direction or to write text for the objects on 
the screen. You can also invoke this option by choosing the View tool from the Align UCS 
drop-down in the Coordinates panel. As soon as you choose this tool, a new UCS is defined 
parallel to the screen of the monitor.

X/Y/Z
With these options, you can rotate the current UCS around the desired axis. You can specify the 
angle by entering the angle value at the required prompt or by selecting two points on the screen 
with the help of a pointing device. You can specify a positive or a negative angle. The new angle 
is taken relative to the X axis of the existing UCS. The UCSAXISANG system variable stores 
the default angle by which the UCS is rotated around the specified axis, by using the X/ Y/ Z 
options of the New option of the UCS tool. The right-hand thumb rule is used to determine the 
positive direction of rotation of the selected axis. You can also invoke the corresponding option 
by choosing the X/Y/Z button from the Rotate UCS drop-down in the Coordinates panel, as 
shown in Figure 1-13. However, in AutoCAD, you can rotate the UCS dynamically using the 
grips and shortcut menu. 
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X
In Figure 1-14, the UCS is rotated using the X option by

Figure 1-13  Tools in the 
Rotate UCS drop-down

specifying an angle about the X axis at the command 
prompt. The first model shows the UCS setting before the 

UCS was relocated and the second model shows the relocated UCS. 
You can also choose the X tool from the Rotate UCS drop-down in 
the Coordinates panel. The prompt sequence that will follow when 
you choose the X tool is given next.

Specify rotation angle about X axis <90>: Specify the rotation 
angle.

Alternatively, you can dynamically rotate the UCS about the X axis by following the steps given 
below:

1.	 Click on the UCS in the drawing area to select it.
2.	 Move the cursor to the grip of the Y or Z axis; a shortcut menu will be displayed, as shown 

in Figure 1-15.
3.	 Choose the Rotate Around X Axis option from the shortcut menu and then rotate the UCS 

dynamically. You can also enter the desired rotation angle in the edit box attached to the 
cursor.

Figure 1-14  Rotating the UCS about the X axis

Figure 1-15  Shortcut menu for UCS rotation

Y
In Figure 1-16, the UCS is rotated using the Y option by specifying an angle about the 
Y axis. The first model shows the UCS setting before the UCS was relocated and the 
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second model shows the relocated UCS. The prompt sequence that will follow when you choose 
the Y tool from the Rotate UCS drop-down is given next.

Specify rotation angle about Y axis <90>: Specify the angle.

Alternatively, you can dynamically rotate the UCS about the Y axis by following the steps given 
below:

1.	 Click on the UCS in the drawing area to select it.
2.	 Move the cursor to the grip of the X or Z axis.
3.	 Choose the Rotate Around Y Axis option from the shortcut menu and rotate the UCS 

dynamically or specify the desired angle.

Figure 1-16  Rotating the UCS about the Y axis

Z
In Figure 1-17, the UCS is rotated using the Z option by specifying an angle about the 
Z axis. The first model shows the UCS setting before the UCS was rotated and the 
second model shows the rotated UCS. The prompt sequence that will follow when you 
choose the Z tool from the Rotate UCS drop-down is given next.

Specify rotation angle about Z axis <90>: Specify the angle.

Alternatively, you can dynamically rotate the UCS about the Z axis by following the steps given 
below:

1.	 Click on the UCS in the drawing area to select it.
2.	 Move the cursor to the grip of the X or Y axis.
3.	 Choose the Rotate Around Z Axis option from the shortcut menu and rotate the UCS 

dynamically or specify the desired rotation angle.
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Note
You can rotate the UCS about any axis also by using the options in the shortcut menu displayed on 
right-clicking on the UCS. To do so, move the cursor on the Rotate Axis sub-menu in the shortcut 
menu and then choose the required option.

Figure 1-17  Rotating the UCS about the Z axis

ZA (ZAxis) Option
This option is used to change the coordinate system by selecting the origin point of the 
XY plane and a point on the positive Z axis. After you specify a point on the Z axis, 
AutoCAD determines the X and Y axes of the new coordinate system accordingly. The 

prompt sequence that will follow when you choose the Z Axis Vector tool from the Coordinates 
panel is given next. 

Specify new origin point or [Object] <0,0,0>: Specify the origin point, as shown in Figure 1-18.
Specify point on positive portion of Z-axis <default>: @ 0,-1,0

Now, the front face of the model will become the new work plane (Figure 1-19) and all 
the new objects will be oriented accordingly. If you give a null response to the Specify 
point on positive portion of Z axis <current> prompt, the Z axis of the new coordinate 
system will be parallel to (in the same direction as) the Z axis of the previous coordinate system. 
Null responses to the origin point and the point on the positive Z axis establish a new coordinate 
system in which the direction of the Z axis is identical to that of the previous coordinate system; 
however, the X and Y axes may be rotated around the Z axis. The positive Z axis direction is also 
known as the extrusion direction.

When the Object option is selected at the Specify new origin point or [Object] <0,0,0> prompt, 
then you will be prompted to select an object. Select an open object and the UCS will be placed 
at the end point nearest to the point of the object selection, with its Z-axis along the tangent 
direction at that end point and pointing away from the object.	
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Figure 1-19  Relocating the UCS using the ZA 
option

Figure 1-18  Specifying a point on the origin

Previous Option
The Previous option is used to restore the current UCS settings to the previous UCS 
settings. AutoCAD saves the last ten UCS settings. You can go back to the previous ten 
UCS settings in the current space using the Previous option. If the TILEMODE is off, 

the last ten coordinate systems in paper space and in model space are saved. You can also invoke 
this option by choosing the UCS, Previous tool from the Coordinates panel. When you choose 
this tool, the previous UCS settings are automatically restored.

NAmed Option
This option is used to name and save the current UCS settings, restore a previously saved 
UCS setting, view a previously saved UCS list, and delete the saved UCS from the list. 
The prompt sequence for this option is given next.

Command: UCS
Current ucs name: *WORLD*
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis] 
<World>: NA
Enter an option [Restore/Save/Delete/?]: Enter an option. 

Depending on your requirement, you can select any one of the following options:

Restore Option
The Restore option of the UCS command is used to restore a previously saved named UCS. 
Once it is restored, it becomes the current UCS. However, the viewing direction of the saved 
UCS is not restored. You can also restore a named UCS by selecting it from the UCS dialog box 
that appears when you invoke the UCS, Named UCS tool from the Coordinates panel. As this 
option does not have a button to restore the Named UCS, you need to choose this option by 
using the UCS command at the Command prompt. The prompt sequence that will follow when 
you invoke the UCS command is given next.
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Enter an option [Restore/Save/Delete/?]: R
Enter name of UCS to restore or [?]: Specify the name of UCS or ENTER to list all the UCS 

You can specify the name of the UCS to be restored or list the UCSs that can be restored by 
entering ? at the previous prompt. The prompt sequence that will be followed is given next.

Enter UCS name(s) to list <*>: Specify the name of the UCS to list or give a null response to list 
all available UCSs.

If you give a null response at the previously mentioned prompt, then the AutoCAD text window 
will be opened listing all the available UCSs.

Save Option
With this option, you can name and save the current UCS settings. The following points should 
be kept in mind while naming the UCS:

1.	 The name can be up to 255 characters long.
2.	 The name can contain letters, digits, blank spaces and the special characters $ (dollar), 

- (hyphen), and _ (underscore).

As this option does not have a tool, you can invoke this option using the Command prompt. 
The prompt sequence that will follow after entering the UCS command is given next.

Current ucs name:  *WORLD*
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/
ZAxis]<WORLD>: NA
Enter an option [Restore/Save/Delete/?]: S
Enter name to save current UCS or [?]: Specify a name to the UCS or press ENTER to list.

Enter a valid name for the UCS at this prompt. AutoCAD saves it as a UCS. You can also list the 
previously saved UCSs by entering ? at this prompt. The next prompt sequence is:

Enter UCS name(s) to list <*>: 

Enter the name of the UCS to list or give a null response to list all the available UCSs.

Delete Option
The Delete option is used to delete the selected UCS from the list of saved coordinate systems.  
As this option does not have a button, you can invoke this option using the Command prompt. 
The prompt sequence that will follow after entering the UCS command is given next.

Current ucs name: *WORLD*
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis]: NA
Enter an option [Restore/Save/Delete/?]: D
Enter UCS name(s) to delete <none>: Specify the name of the UCS to delete.

The UCS name you enter at this prompt is deleted. You can delete more than one UCS by 
entering the UCS names separated with commas or by using wild cards. 
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? Option
By invoking this option, you can list the name of the specified UCS. This option gives you the 
name, origin, and X, Y, and Z axes of all the coordinate systems relative to the existing UCS. If 
the current UCS has no name, it is listed as WORLD or UNNAMED. The choice between these 
two names depends on whether the current UCS is the same as the WCS. The prompt sequence 
that will be displayed when you invoke this option using the Command prompt is given next.

Current ucs name:  *WORLD*
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis] 
<WORLD>: NA
Enter an option [Restore/Save/Delete/?]: ?
Enter UCS name(s) to list <*>: 

Apply Option
The Apply option applies the current UCS settings to a specified viewport or to all the 
active viewports in a drawing session. If the UCSVP system variable is set to 1, each 
viewport saves its UCS settings. The Apply option is not displayed at the Command 

prompt as an option for the UCS command. Therefore, you have to choose the Apply button 
from the UCS toolbar. The prompt sequence that will follow when you choose this button is 
given next.

Pick viewport to apply current UCS or [All]<current>: Pick inside the viewport or enter A to 
apply the current UCS settings to all viewports.

Origin Option
This option is used to define a new UCS by changing the origin of the current UCS, 
without changing the directions of the X, Y, Z axes, see Figures 1-20 and 1-21. The new 
point defined becomes the origin point (0,0,0) for all the coordinate entries, until the 

origin is changed again. You can specify the coordinates of the new origin or click on the screen 
using the pointing device. Alternatively, choose the Origin tool from the Coordinates panel to 
specify the coordinates of the new origin. The prompt sequence that will follow when you choose 
this tool is given next. 

Specify new origin point <0,0,0>: Specify the origin point, as shown in Figure 1-20.

Tip
If you do not provide the Z coordinate for the origin, the current Z coordinate value will be assigned 
to the UCS.
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Figure 1-21  Relocating the UCS for the new 
origin

Figure 1-20  Defining a new origin for the UCS

3-Point Option
The 3-Point option is the default option of the UCS command. With this option, you can 
establish a new coordinate system by specifying a new origin point, a point on the positive 
side of the new X axis, and a point on the positive side of the new Y axis (Figure 1-22). 

The direction of the Z axis is determined by applying the right-hand rule about which you will 
learn in the next chapter. This option can also be used to align the UCS at any angled surface. 
The prompt sequence that will follow when you choose the 3-Point tool from the Coordinates 
panel is given next.

Specify new origin point <0,0,0>: Specify the origin point of the new UCS.
Specify point on positive portion of X-axis <default>: Specify a point on the positive portion 
of the X axis.
Specify point on positive-Y portion of the UCS XY plane<default>: Specify a point on the 
positive portion of the Y axis.

A null response to the Specify new origin point <0,0,0> prompt will lead to a coordinate 
system in which the origin of the new UCS is identical to that of the previous UCS. Similarly, 
null responses to the point on the X or Y axis prompt will lead to a coordinate system in which 
the X or Y axis of the new UCS is parallel to that of the previous UCS. In Figure 1-23, the UCS 
has been relocated by specifying three points (the origin point, a point on the positive portion 
of the X axis, and a point on the positive portion of the Y axis).
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Figure 1-23  UCS at a new positionFigure 1-22  Relocating the UCS using the 
3-Point option

Example 1 		     					       3-Point
In this example, you will draw a tapered rectangular block. After drawing it, you will align the 
UCS with the inclined face of the block by using the dynamic alignment. Next, you will draw a 
circle on the inclined face. The dimensions for the block and the circle are shown in Figure 1-24.

Figure 1-24  Model for Example 1

The steps to do this example are given next.

• Draw the edges of the bottom face of the tapered block.
• Specify a new origin.
• Draw the edges of the top face of the tapered block.
• Draw the remaining edges of the block.
• Align the UCS to the inclined face.
• Draw the circle on the inclined face.
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These steps are discussed next.

1.	Start a new drawing and choose the Line tool. The prompt sequence is given next.

Specify first point: 1,1
Specify next point or [Undo]: @10,0
Specify next point or [Undo]: @0,8
Specify next point or [Close/Undo]: @-10,0
Specify next point or [Close/Undo]: C 

2.	As the top face of the model is at a distance of 8 units from the bottom face in the positive Z 
direction, you need to define a UCS at a distance of 8 units to create the top face. To do so, 
select the UCS and then move the cursor to the rectangular grip displayed at the intersection 
of the three axes; a shortcut menu will be displayed. Choose the Move Origin Only option; 
AutoCAD will prompt you to specify a new origin point. The prompt sequence is as follows:

Specify origin point : 0,0,8

3.	Choose the Line tool from the Draw panel. The prompt sequence is as follows:

Specify first point: 1,1
Specify next point or [Undo]: @6,0
Specify next point or [Undo]: @0,8
Specify next point or [Close/Undo]: @-6,0
Specify next point or [Close/Undo]: C

4.	When you open a new drawing, you view the model from the top view by default. Therefore, 
when viewing from the top, the three edges of the top side overlap with the corresponding 
bottom edges. As a result, you will not be able to see all the edges. However, you can change 
the viewpoint to clearly view the model in 3D. Choose SE Isometric from the View Controls 
list in the In-Canvas Viewport Controls to orient the view to the SE isometric view. Now, you 
can see the 3D view of the objects, see Figure 1-25.

5.	Join the remaining edges of the model using the Line tool. The model after joining all 
edges should look similar to the one shown in Figure 1-26.

Now, dynamic alignment of UCS can be done with a surface, a mesh, and a solid face but the 
inclined portion is a wire frame. So, you need to convert the wire frame into a  surface by using 
the Region tool.

6. Invoke the Region tool from the Draw panel in the Home tab; AutoCAD will prompt you to 
select objects for generating a region. Next, select the four edges bounding the inclined face 
and press ENTER; a region will be generated.

7. Next, select the UCS and place the cursor on the rectangular grip; a shortcut menu will be 
displayed. Choose the Move and Align option from the shortcut menu; you will be prompted 
to select a face or origin point.



1-19The User  Coordinate  Sys tem

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 1-25  3D view of the objects Figure 1-26  Model after joining all the edges

8.  Select the inclined face by moving through the edge to which you want the X axis to be
     parallel or you can align the axes by dynamically rotating them. In this case, the X axis is
     parallel to P1P2 line; refer to Figure 1-27.

9.  Choose the Center, Radius tool from the Circle drop-down in the Draw panel and draw the
     circle on the inclined face.

The final model should look similar to the one shown in Figure 1-28.

Figure 1-27  Model after aligning the UCS on the 
inclined face

Figure 1-28  Final model for Example 1

MANAGING THE UCS THROUGH THE DIALOG BOX
  Ribbon:  Visualize > Coordinates > UCS, Named UCS		  Command:  UCSMAN	  
  Menu Bar: Tools > Named UCS	 		  				  

In AutoCAD, you can save and restore the UCS by using the UCS, Named UCS tool from 
the Coordinates panel. On choosing this tool, the UCS dialog box will be displayed, as 
shown in Figure 1-29. This dialog box is used to restore the saved and orthographic UCSs, 

specify the UCS icon settings, and rename UCSs. This dialog box has three tabs: Named UCSs, 
Orthographic UCSs, and Settings which are discussed next.
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Figure 1-29  The Named UCSs tab of the UCS dialog box

Named UCSs Tab
The list of all coordinate systems defined (saved) on your system is displayed in the list box of the 
View tab. The first entry in this list is World, which means WCS. The next entry will be Previous, 
if you have defined any other coordinate systems in the current editing session. Selecting the 
Previous entry and then choosing the OK button repeatedly allow you to go backward through 
the coordinate systems defined in the current editing session. If you have created a new UCS  as 
the current coordinate system and not named it, then Unnamed will be the first entry in the list. 
Double-click on the name and rename it. Else, the unnamed UCS will disappear on selecting 
other UCS. If there are a number of viewports and unnamed settings, only the current viewport 
UCS name will be displayed in the list. The current coordinate system is indicated by a small 
pointer icon to the left of the coordinate system’s name. The name of the current UCS is also 
displayed next to Current UCS on top of the UCS dialog box. To make other coordinate system 
current, select its name in the UCS Names list, choose the Set Current button, and choose the OK 
button. Alternatively, select the required UCS from the Named UCS Combo Control drop-down 
list available in the Coordinates panel of the View tab. To delete a coordinate system created 
previously, select its name, and then right-click to display a shortcut menu. Choose the Delete 
button to delete the selected UCS name. To rename a coordinate system, select its name and 
then right-click to display a shortcut menu and choose Rename. Now, enter the new name. You 
can also double-click on the name you need to modify, and then change the name. The other 
options in the shortcut menu are Set Current and Details.

Tip
All the changes and updating of the UCS information in the drawing are carried out only after 
you choose the OK button.

If you want to check the current coordinate system’s origin and X, Y, and Z axis values, select a 
UCS from the list and then choose the Details button; the UCS Details dialog box (Figure 1-30) 
containing that information is displayed. Alternatively, right click on the name of the specific 
UCS in the list box and then choose the Details option from the shortcut menu.  



1-21The User  Coordinate  Sys tem

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 1-30  The UCS Details dialog box

Orthographic UCSs Tab 
Different orthographic views are listed in the Orthographic UCSs tab, as shown in Figure 1-31. 
You can select any one of the six orthographic views of the WCS or the user defined coordinate 
system using the UCS dialog box. To define an orthographic coordinate system relative to a UCS, 
select it from the Relative to drop-down list. Next, select the orthographic view from the list of 
preset orthographic views, and then choose the Set Current button; the UCS icon is placed at 
the corresponding view. You can also right-click on the specific orthographic UCS name in the 
list and choose Set Current from the shortcut menu. The name of the current UCS is displayed 
above the list of orthographic view. If the current settings have not been saved and named, the 
Current UCS name displayed is Unnamed.

Figure 1-31  The Orthographic UCSs tab of the UCS dialog box

The Depth field in the list box of this dialog box displays the distance between the XY plane of 
the selected orthographic UCS setting and the parallel plane passing through the origin of the 
UCS base setting. The UCSBASE system variable stores the name of the UCS, which is considered 
as the base setting; that is, it defines the origin and orientation. You can enter or modify the 
values of depth by double-clicking on the depth value of the selected UCS in the list box.
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On doing so, the Orthographic UCS depth dialog box (Figure 1-32) will be displayed, where 
you can enter new depth values. You can also right-click on a specific orthographic UCS in the 
list box to display a shortcut menu. Choose Depth to display the Orthographic UCS depth 
dialog box. Enter a value in the edit box. If you need to pick a position from the drawing area, 
choose the Select new origin button available next to the edit box; the dialog box will disappear 
allowing you to specify a new origin or depth on the screen.

Figure 1-32 The Orthographic UCS depth dialog box

Choosing the Details button displays the UCS Details dialog box with the origin and the X, Y, 
Z coordinate values of the selected UCS. You can also choose Details from the shortcut menu 
that is displayed on right-clicking on a UCS in the list box. The shortcut menu also has a Reset 
option. Choosing Reset from the shortcut menu restores the selected UCS to its default settings. 
Also, the depth value, if assigned, becomes zero.

Settings Tab 
The Settings tab of the UCS dialog box (Figure 1-33) is used to display and modify the UCS and 
UCS icon settings of a specified viewport. If you choose the inclined arrow on the Coordinates 
panel, the UCS dialog box will be displayed with the Settings tab chosen. The options in this 
dialog box are discussed next.

UCS Icon settings Area
Selecting the On check box displays the UCS icon in the current viewport. This process is similar 
to using the UCSICON command and enables you to set the display of the UCS icon to on or 
off. If you select the Display at UCS origin point check box, the UCS icon is displayed at the 
origin point of the coordinate system in use in the current viewport. If the origin point is not 
visible in the current viewport, or if the check box is cleared, the UCS icon is displayed in the 
lower left corner of the viewport. Selecting the Apply to all active viewports check box applies 
the current UCS icon settings to all the active viewports in the current drawing.

UCS settings Area
This area of the Settings tab in the UCS dialog box specifies the UCS settings for the current 
viewport. Selecting the Save UCS with viewport check box saves the UCS with the viewport. This 
setting is stored in the UCSVP system variable. If you clear this check box, the UCSVP variable 
will be set to 0 and the UCS of the viewport will reflect the UCS of the current viewport. When 
you select the Update view to Plan when UCS is changed check box, the plan view is restored 
after the UCS in the viewport is changed. When the selected UCS is restored, the plan view is 
also restored. The value is stored in the UCSFOLLOW system variable.
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Figure 1-33  The Settings tab of the UCS dialog box

SYSTEM VARIABLES
The coordinate value of the origin of the current UCS is held in the UCSORG system variable. 
The X and Y axis directions of the current UCS are held in the UCSXDIR and UCSYDIR 
system variables, respectively. The name of the current UCS is held in the UCSNAME variable. 
All these variables are read-only. If the current UCS is identical to the WCS, the WORLDUCS 
system variable is set to 1; otherwise, it holds the value 0. The current UCS icon setting can be 
examined and manipulated with the help of the UCSICON system variable. This variable holds 
the UCS icon setting of the current viewport. If more than one viewport is active, each one can 
have a different value for the UCSICON variable. If you are in paper space, the UCSICON 
variable will contain the setting for the UCS icon of the paper space. The UCSFOLLOW 
system variable controls the automatic display of a plan view when you switch from one UCS to 
another. If UCSFOLLOW is set to 1 and you switch from one UCS to another, a plan view is 
automatically displayed. The UCSAXISANG variable stores the default angle value for the X, 
Y, or Z axis around which the UCS is rotated using the X, Y, Z options of the New option of the 
UCS command. The UCSBASE variable stores the name of the UCS that acts as the base; that 
is, it defines the origin and orientation of the orthographic UCS setting. The UCSVP variable 
decides whether the UCS settings are stored with the viewport or not.

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 You can move the World Coordinate System from its original position. (T/F)

2.	 The View tool in the Align UCS drop-down of the Coordinate panel of the Visualize tab  
is used to define a new UCS whose XY plane is parallel to the current viewing plane. (T/F)

3.	 An ellipse cannot be used as an object for defining a new UCS. (T/F)
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4.	 While moving the UCS, if you do not specify the Z coordinate of the new point, the previous 
Z coordinate will be taken for the new value. (T/F)

5.	 By default, the __________ is established as the coordinate system in the AutoCAD 
environment.

6.	 The __________ coordinate system can be moved to and rotated about any desired location.

7.	 Once a saved UCS is restored, it becomes the __________ UCS.

8.	 You can change the 3D UCS icon to a 2D UCS icon using the __________ option of the UCS 
Icon dialog box.

9.	 The __________ point of the 3D face defines the origin of the new UCS.

10.  In dynamic alignment of UCS for a flat planar face, the  ___________  will always be 		
       parallel to the edge through which the UCS is moved on the face.

 Review Questions 
Answer the following questions:

1.	 Which of the following options is used to restore the previous UCS settings?

		  (a) ZAxis		  (b) Restore
		  (c) Previous		  (d) Save	

2.	 Which of the following options is used to list names of all the saved UCSs?

		  (a) ZAxis		  (b) Restore
		  (c) ?			   (d) Save

3.	 Which of the following system variables is used to control the automatic display of the plan 
view when you switch to the new UCS?

		  (a) UCSORG		  (b) UCSFOLLOW
		  (c) UCS			  (d) UCSBASE

4.	 Which of the following system variables is used to store the coordinates of the origin of the 
current UCS?

		  (a) UCSICON	 	 (b) UCSORG
		  (c) UCSVP	 	 (d) UCSFOLLOW

5.	 Which of the following tools is used to manage the UCS using a dialog box?

		  (a) UCS Icon, Properties		  (b) UCS, Named UCS
		  (c) UCS					    (d) UCS, World
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6.	 The line width of the UCS icon can be changed. (T/F)

7.	 The size of the UCS icon can vary between 5 and 100. (T/F)

8.	 The name of the current UCS is stored in the UCSNAME variable. (T/F)

9.	 The selection of the UCS can be controlled by using the options in the Settings tab of the 
UCS dialog box. (T/F)

10.	 The __________ variable is used to control the X axis direction of the current UCS.

11.	 The __________ direction is known as the extrusion direction.

12.	 The lineweight of the UCS icon can be changed using the __________ option of the UCS 
Icon dialog box.

13.	 The __________ option of the UCS command is used to change the origin of the current 
UCS.

14.	 The __________ variable is used to control the Y axis direction of the current UCS.

15.	 The __________ variable is used to store the default angle value by which the UCS will be 
rotated.

Exercises 1 through 4				          
Draw the objects shown in Figures 1-34 through 1-37. Assume the missing dimensions. Use the 
UCS tools to align the UCS icon and then draw the objects.

Figure 1-34  Drawing for Exercise 1 Figure 1-35  Drawing for Exercise 2
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Figure 1-36  Drawing for Exercise 3 Figure 1-37  Drawing for Exercise 4

Exercise 5							          	
Create the drawing shown in Figure 1-38. Align the UCS icon and then draw the objects. Note 
that in this drawing the left side of the transition should make a 90-degree angle with the bottom.

Figure 1-38  Model for Exercise 5

Exercise 6							             
Create the drawing shown in Figure 1-39. Assume its missing dimensions. Position the UCS icon 
and then draw the objects. Note that in this drawing, the center of the top polygon is offset at 
0.75 units from the center of the bottom polygon.
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Figure 1-39  Model for Exercise 6

Exercises 7 and 8					           
In these exercises, you will create the drawing shown in Figures 1-40 and 1-41. Assume the 
missing dimensions.

Figure 1-40  Model for Exercise 7 Figure 1-41  Model for Exercise 8
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 Answers to Self-Evaluation Test 
1. F, 2. T, 3. F, 4. T, 5.  World Coordinate System, 6. user, 7. current,  8. Properties, 9. first, 10. 
X axis, 


